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OFITE is pleased to introduce the new Model 3025 Pressurized Viscometer. 
This fully-automated system accurately determines the flow characteristics of 
fracturing fluids, drilling fluids, and cement slurries in terms of shear stress, 
shear rate, time, and temperature at pressure up to 2500 psi.

Using the exclusive ORCADA® software, a computer novice can operate the 
Model 3025, and yet the system is versatile enough for advanced research 
and demanding test parameters. 

#130-75-003-1	 Band Heater, 300 Watt
#130-75-27	 3/16" T-handle Allen Key
#130-78-04	 Sample Thermocouple
#130-78-05	 Main Seal
#130-78-13	 B1 Bob, Hastelloy with Threads for Stainless Steel
#130-78-17	 Bob Shaft Bearing
#130-78-20	 O-ring for Rotor Cup
#130-78-34	 Packing Washer
#130-78-36	 O-ring for Rotor Tube
#130-79-19	 Cable, USB to RS232
#130-81-003	 O-ring for Valve Stem, Upper
#130-81-07	 Valve Stem
#130-81-071	 Rotor, R1 (C276)
#130-81-082	 Torsion spring, 4,000 Dyne/cm2

#130-81-086	 Screw, Socket Head, 0.80 × 3/16"
#130-81-550	� Fitting, Male Connector, 1/8" Tube OD × 5/16-24 Male O-

seal
#130-81-506-1	 Retaining Ring, Internal, Single Turn Spiral
#130-83-023	 Seal Nut
#130-83-505	 Bearing, Main, Deep Groove
#130-83-508	 O-ring for Cell Cap
#130-83-510	 Bob Shaft Bearing
#130-83-511	 Retainer Ring, External, Spiral
#130-83-512	 Retainer Ring, Internal
#130-83-610	 Bearing, Tube
#130-83-611	 Bearing, Insert, Bob Shaft
#130-83-612A	 Shaft Assembly
#132-83	 Calibration Fluid, 200 cP, 16 oz; Certified
#142-54	 O-ring for Bob Shaft, Upper
#152-37	 AC Power Cord (115 Volt Only)
#152-38	 AC Power Cord (230 Volt Only)
#153-00	 Bottle Brush
#153-55	 Silicone Stopcock Grease; Dow Corning; 150g Tube
#153-67	 60cc Disposable Syringe
#170-17	 O-ring for Valve Stem, Lower
#512-03-800	 Magnetic Encoder Sensor Board

Intro

Components
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Optional:
#130-81-079	 Torsion Spring, 500 Dyne/cm2

#130-81-080	 Torsion Spring, 1,000 Dyne/cm2

#130-81-082	 Torsion Spring, 4,000 Dyne/cm2

#130-81-084	 Torsion spring, 16,000 Dyne/cm2

#132-84	 Calibration Fluid, 20 cP, 16 oz
#132-81	 Calibration Fluid, 50 cP, 16 oz
#132-80	 Calibration Fluid, 100 cP, 16 oz
#132-83	 Calibration Fluid, 200 cP, 16 oz
#132-82	 Calibration Fluid, 500 cP, 16 oz
#165-44-2	 High-Temperature Thread Lubricant, 7 gram Pouch
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Features -- High Pressure - Up to 2,500 psi (17.2 MPa)

-- High Temperature - Up to 500°F (260°C)

-- Low Motor Shear Rates - As low as 0.01s-1

-- Small Footprint - Only 12" × 12" (30 × 30 cm). The all-in-one design 
includes the heating mechanism.

-- Couette Geometry - Uses traditional Bobs and Rotor for measurements 
that are easy-to-translate (shear stress range 0 – 4000 dynes/cm2).

-- Computer Controlled - Using the exclusive ORCADA® software system, 
this Viscometer is ideal for advanced research and demanding test 
parameters.

-- Data Acquisition - Store your data in a text format or in a Microsoft Excel 
file for easy access and reporting capabilities.
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Specifications Range of Measurement for Model 3025
Rotor - Bob R1B1 R1B2 R1B3 R1B4 R1B5

Basic Data
Rotor Radius, RR (cm) 1.8415 1.8415 1.8415 1.8415 1.8415
Bob Radius, RB (cm) 1.7245 1.2276 0.8622 0.8622 1.5987
Bob Height, L (cm) 7.62 7.62 7.62 3.81 7.62
Shear Gap (cm) 0.117 0.6139 0.9793 0.9793 0.2428
R Ratio, RB/RR 0.9365 0.377 0.468 0.468 0.8503
Max Temperature (°C) 260 260 260 260 260
Min Temperature (°C) 0 0 0 0 0
Shear Stress Range (dyne/cm2)
Spring, 130-81-080 1 - 1000 2 - 2000 4 - 4000 8 - 8000 1 - 1160
Spring, 130-81-082 4 - 4000 8 - 8000 16 - 16000 32 - 3200 4 - 4650
Spring, 130-81-084 16 -16000 32 - 32000 64 - 64000 128-128000 19-18600
Shear Rate Range1

Shear Rate Constant 
(s-1 / RPM) 1.7023 0.3770 0.2682 0.2682 0.8503

Shear Rate Range (s-1)
0.01 RPM 0.01702 0.00377 0.00238 0.00238 0.008503
0.1 RPM 0.1702 0.0377 0.02382 0.02382 0.08503
1.0 RPM 1.702 0.377 0.2382 0.2382 0.8503
10 RPM 17.02 3.77 2.382 2.382 8.503
100 RPM 170.2 37.7 23.82 23.82 85.03
1000 RPM 1702 377 238.2 238.2 850.3
Viscosity Range (cP)
Minimum Viscosity 
with 130-81-0802 0.1 0.5 1.7 3.4 0.1

Maximum Viscosity 
with 130-81-0803 5,875,000 53,125,000 168,750,000 337,500,000 13,750,000

Minimum Viscosity 
with 130-81-0822 0.2 2.1 6.8 13.6 0.5

Maximum Viscosity 
with 130-81-0823 23,500,000 212,500,000 675,000,000 1,350,000,000 55,000,000

Minimum Viscosity 
with 130-81-0842 1.0 8.5 27.2 54.4 1.9

Maximum Viscosity 
with 130-81-0843 94,000,000 850,000,000 2,700,000,000 5,400,000,000 220,000,000

1 Lower shear rates available on special order.
2 At 1,000 RPM
3 At .01 RPM
When using the 130-81-079 spring use a maximum speed of 300 RPM.
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Instrument Geometry True Couette Coaxial Cylinder
Motor Technology Stepper
Motor Speeds (RPM) Variable Speed Range .01 - 1,000
Speed Accuracy (RPM) .001
Shear Rate Range (sec-1) .01 - 1,022
Readout Computer Control and Data Acquisition
Heat System 300 Watt, Max Temp 500°F (260°C)
Temperature Measurement Type “J” Thermocouple
Automatic Tests API Cementing, Mud and Fracture Rheology
Power Requirements 115 or 230 Volts AC, 50/60 Hz
Weight ~90 lb (41 kg)
Dimensions 12" × 17.7" × 27.25" (31 × 45 × 69 cm)
Communication
Requirements RS-232 Serial Port Ethernet

Operating System Windows 7 or later

Viscosity Conversions
To convert from units on left side to units on top, multiply by factor @ intercept.

Centipoise
(cP)

Poise 
(P) g/(cm × s) (mN × s)m2 mPa × s (lb × s)

100 ft2

Centipoise 1 0.01 0.01 1 1 0.002088
Poise 100 1 1 100 100 0.2088

g/(cm × s) 100 1 1 100 100 0.2088
(mN × s)m2 1 0.01 0.01 1 1 0.002088

mPa × s 1 0.01 0.01 1 1 0.002088
lb × s
100 ft2 478.93 4.789 4.789 478.93 478.93 1

From
To

Shear Stress Conversions
To convert from units on left side to units on top, multiply by factor @ intercept.

Dyne/cm2 Pa lb/100ft2 lb/ft2 DR

Dyne/cm2 1 0.1 0.2084 0.002084 0.1957

Pa 10 1 2.084 0.02084 1.957

lb/100ft2 4.788 0.4788 1 0.01 0.939

lb/ft2 478.8 47.88 100 1 93.9

DR 5.107 0.5107 1.065 0.01065 1
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Setup
Viscometer

1.	 On the back panel, connect a Nitrogen source to the ¼" NPT fitting. 

2.	 Connect the Viscometer to the computer using either a 9-pin RS232 cable 
or an Ethernet cable.

3.	 Plug the power cord into an AC power source.
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Setup
System Test

1.	 Turn the unit on. The power switch is located on the front panel.

2.	 If the Heater is raised, lower it:

a.	 Hold the Heater with one hand.

b.	 With the other hand, press the blue button on the Stop Pin and pull 
the Stop Pin out.

c.	 Gently lower the Heater until it rests on the base of the Viscometer.

The Rotor Cup is already attached to the Viscometer in order to protect 
the Bob Shaft during shipping. Always handle the Bob Shaft carefully; 
bending it will result in poor viscosity readings.

Heater

Stop Pin
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3.	 To remove the Rotor Cup, unscrew the Rotor Nut and pull the Rotor Cup 
straight down.

4.	 Carefully apply a thin coating of high-temperature thread lubricant (#165-
44-2) to the Bob Shaft threads.

5.	 To install the Bob, slide it onto the Bob Shaft with the tapered end down 
and screw it securely into place. 

An R1B1 Bob/Rotor combination is standard for the Model 3025 
Viscometer, however other combinations are available. See page 5 for 
more information.

Rotor Cup

Valve Stem

Rotor Nut

Bob

Bob Shaft
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6.	 Turn on the computer and open the ORCADA® software (see page 
12 for instructions).

7.	 From the menu bar at the top of the screen, select “Utilities” and then 
“Calibrate Shear Stress”. Check the “Temperature” field to verify that 
it shows room temperature. Then, confirm that the value in the “Shear 
Stress Raw” fluctuates when you gently turn the Bob with your hand.

If either of these values does not display as expected, make sure the 
Model 3025 is turned on and that all cables are securely connected. If the 
problem is still not corrected, return to the “Main Screen” in the ORCADA® 
software and choose “Edit” and then “Options”. In the “COM Port” drop-
down menu, choose a different port and try again. See page 21 for 
information about the “Options” screen.

8.	 It is recommended that a Calibration procedure be run due 
to the possibility of mishandling during shipment. Refer to the 
“Calibration” section on page 15 for detailed instructions on calibrating 
the unit.
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Setup
Preparing for a Test

1.	 Install the Bob as described in steps 1 - 5 on page 8.

2.	 Fill the Rotor Cup with the proper amount of fluid based on the Bob you 
are using. Refer to the chart below.

Bob B1 B2 B3 B4 B5 XB1 XB2 XB5
Sample Amount (mL) 42 78 96 104 52 32 73 44

3.	 Hold the Rotor Cup by hand and position the Bob in the center. Push the 
Rotor Cup up past the o-ring. Hold the Rotor Cup in place and screw the 
Rotor Cup nut into place.

4.	 Raise the Heater:

a.	 Position the Heater beneath the Rotor Cup.

b.	 With one hand, raise the Heater up as far as it will go.

c.	 With the other hand, push the blue button on the Stop Pin and push 
the Stop Pin into the hole on the leg. The Stop Pin will hold the Heater 
in place.

5.	 On the right-hand side of the Viscometer, turn the Nitrogen valve to Fill 
Cell.

6.	 To pressurize the sample, slowly rotate the regulator knob clockwise. To 
reduce pressure, slowly rotate the regulator knob counterclockwise at a 
rate no greater than 60 psi per minute.

Pressure is only necessary for tests temperatures above 200°F (95°C). 
The heaters will be deactivated if the sample is not pressurized enough 
to prevent boiling. The ORCADA® software will indicate this with a yellow 
alarm light. The alarm light will turn green when the appropriate pressure 
is applied to the sample. Refer to the chart below for the minimum 
pressure requirements.

7.	 Once the pressure is set and the heater is in place, the Model 3025 is 
ready to run a test.

Temperature Pressure
Ambient - 200°F (Ambient - 93.3°C) 0 psi (0 kPa)

201° - 295°F (93.9° - 146.1°C) 100 psi (690 kPa)
296° - 355°F (146.7° - 179.6°C) 200 psi (1,380 kPa)
356° - 395°F (180.1° - 201.8°C) 300 psi (2,070 kPa)
396° - 445°F (202.4° - 229.6°C) 500 psi (3,450 kPa)
446° - 500°F (230.2° - 260.2°C) 800 psi (5,520 kPa)
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Software Start 1.	 1.	 Double-click the “ORCADA®” icon on the desktop.

2.	 The first time you run the software, you will be asked to select a hardware 
configuration. Select “Model 3025” and click “OK”. You will now see the 
Main Screen.

Main Screen

“Start Test” - This button starts a test in Auto Mode. Once a test is started, 
this button becomes the “Abort Test” button. Click here to stop the test.

“Cement” - This button performs a standard cement test based on 
API specifications.

“Mud” - This button performs a standard mud test based on 
API Specifications.

When running the “Mud” and “Cement” tests, the values for “Dead Time” and 
“DAQ Time” on the Options screen should be ignored. Temperature and 
pressure control, which are disabled during custom Auto-Mode tests, are 
available during a “Mud” or “Cement” test.

“Progress” - This button opens the Test Progress window, which shows all of 
the steps of the current test and highlights the one currently in process.

“Status” - This box at the top of the screen shows the current status of the 
test.

Available Tests Log Indicator Status
Communication 

Indicator

Bath Control

Key

Manual Mode 
Controls

Analysis Data Process Variables
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“Comm Timeout” - This light will be off when the PC is successfully 
communicating with the Viscometer. If communication is interrupted for any 
reason, the light will shine red to indicate a problem.

“Start Logging” - This button is available in manual mode only. Click here to 
begin recording test data. The light next to this button will shine green while 
logging is in progress.

“Cond Pause” - This button will pause a test during the conditioning phase 
and put the software into Manual Mode. While the test is paused, the motor 
and heat controls can be controlled in the same manner as in a standard 
Manual Mode test.

To resume the test, click the “Cond Pause” button again. You will be asked if 
you want to “Continue” the test with the remaining conditioning time or if you 
want to “Override” the remaining time and extend the effective conditioning 
time. If you choose to “Continue”, the time remaining in the conditioning cycle 
will appear as though the test was never paused. If you choose to “Override”, 
the time remaining in the conditioning cycle will resume at the point where the 
test was paused.

For example, assume a test has a conditioning time of 10 minutes and the 
test is paused at the 5 minute mark for 1 minute. If the test is unpaused 
using the “Continue” option, the time remaining in the conditioning cycle will 
be 4 minutes. However, if the test is unpaused using the “Override” option, 
the time remaining in the conditioning cycle will be five minutes, making the 
effective total conditioning time 11 minutes.

“Raw File Save Period” - This field determines how often data is recorded 
during a test.

“Experiment Name” - This field will be used to identify the experiment later. 
This field is required before starting a test in Auto Mode or starting logging in 
Manual Mode.
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“Bob” - Select the type of Bob currently being used in the unit. An incorrect 
value in this field will adversely affect your test results.

“Key” - The checkboxes next to the graph key enable and disable graphing 
of the indicated values. For example, to exclude RPM from the graph, 
uncheck the “RPM” box. You can also customize the appearance of the lines 
on the graph by clicking on the line example on the right side of the key.

“Manual Mode Controls” - The manual mode controls, in the bottom left-
hand corner of the screen, adjust the Rotor speed and the temperature while 
the unit is operating in manual mode.

“Rotation” - This field determines the rotational speed. The drop-down 
box beneath the field set the units to either RPM or 1/s.

“Enable” - Place a check in this box to engage the motor. Uncheck the 
box to stop the motor.

“Temp” - This field determines the test temperature. The drop-down list 
beneath the field sets the units to either °F or °C.

“Enable” - Place a check in this box to enable temperature control. If 
the value in the “Temp” field is higher than the sample temperature, the 
heaters will engage to heat the sample.

“PreHeat” - The software will not heat a sample above 200°F (93°C) 
unless the sample is pressurized. The preheat button allows the software 
to heat the bath to higher temperatures without giving a low pressure 
warning. Enter a value in the “Temp” field and check the “PreHeat” box to 
preheat the bath prior to heating the sample.

“Cool” - Not available on the Model 3025.

“Clear” - This button removes all data from the graph.

“Analysis Model” - This field, below the graph, displays the current Analysis 
Model being used in the test. This variable is set in the Test Builder (refer to 
page 23 for more information).

“Analysis Data” - This chart shows the calculated values based on the 
Analysis Model being used for the test. This data will not display until after the 
analysis sweep is completed.

“Temperature”, “Shear Stress”, “Viscosity”, “Shear Rate”, “RPM” - 
These fields display the current value for these variables. They are display 
only. The drop-down box next to the “Shear Stress” field changes the units of 
the Shear Stress variable. The units can be set to: Dyne/cm2, lb/100ft2, Pa., 
Dial Reading, lb/ft2
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Calibration The ORCADA® calibration program should be run before performing the first 
test. Additional calibration is recommended when:

1.	 The Bob is changed.
2.	 The unit has been sitting unused for several days.
3.	 The unit has been serviced (i.e. bearings changed).
4.	 If the “r^2” value displayed in the analysis model is below .99 during a 

sweep.
5.	 The Shear Stress value on the main screen is not 0 when the Rotor is 

not turning.
6.	 Every two weeks during normal operation.

According to API Recommended Practice 10B-2, viscometers being used 
for testing well cement should be calibrated quarterly. API Recommended 
Practice 13B-1 and 13B-2 specify viscometers being used for drilling fluids 
should be checked monthly.

The calibration fluid should be stored at room temperature and away from 
direct sunlight. The shelf life of the calibration fluid is 2 years. The calibration 
fluid used during the calibration program should be checked for suspended 
solids and clarity prior to being poured back into the bottle for storage. Cloudy 
calibration fluid should be disposed of properly.

1.	 Open the ORCADA® software. From the menu bar select “Utilities” and 
then “Calibrate Shear Stress”.

2.	 Observe the “Shear Stress Raw” value. If the Shear Stress Raw value 
is not between 950 and 1000, you must adjust the Transducer Cap. See 
page 46.

3.	 Select a calibration fluid from the “Cal Fluid Batch” drop-down list. If the 
list is empty, click the “Fluid Manager” button to add new fluid batches. 
Refer to page 18 for instructions.

If the “Temp Out of Range” light shines red, the current sample 
temperature is out of the specified range for the calibration fluid. The 
sample will have to be heated or cooled to be within the acceptable range 
before calibration.

Do not attempt a calibration if the sample is not within the 
appropriate temperature range.

When using the 130-81-079 spring, use 200 cP fluid with a B5 Bob and 
100 cP fluid with a B1 Bob.
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4.	 Choose a set of calibration rates from the “Rate Set” drop-down list.

To create or edit a rate set, click the “Calibration Rates” 
button. To create a new set, click the “New” button and 
enter a name and the rotational speeds. To edit a set, 
select it in the “Rate Set” list, then change the rotational 
speeds as necessary.

Calibrating at speeds above 300 RPM can adversely 
affect results. All speeds in your rate set should be 
greater than 0 and less than or equal to 300.

5.	 Click the “Start Calibration” button to begin the calibration.

Once the calibration has started, the software will begin filling in the chart 
and plotting the results on the graph.

6.	 As the calibration proceeds, the software will begin to display the 
collected data in the chart. At the end of the calibration, the software 
will calculate the “r^2C” value, which measures the accuracy of the 
calibration. If this value is less than 0.9990, recalibrate the unit. If this 
value is still low, change the Bob Shaft Bearings (see page 34 and 
35 for instructions) and try the calibration again. If the Model 3025 still 
does not calibrate, the unit will require servicing by an OFITE technician.

7.	 When the calibration is complete, check the r^2C value to make sure it 
is greater than .9990. If it is, click the “OK” button and enter a title for the 
calibration.

Rate Sets



OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 832-320-7300 / Fax: 713-880-9886 / www.ofite.com 17

“S.S. Reference” - the shear stress as calculated by the software

“S.S. Raw” - the actual signal coming from the unit

“RPM” - rotational speed

“Viscosity Reference” - the viscosity of the sample as calculated by the 
software

“Temp” - the temperature of the sample

“S.S. Best Fit” - shear stress value for a perfect calibration

“Viscosity Best Fit” - viscosity value for a perfect calibration

“S.S. Fit Error” - deviation of actual shear stress from “S.S. Best Fit”

“r^2” - This is a measure of the accuracy of the calibration. It will be 
calculated at the end of the calibration cycle. If this value does not read 
greater than 0.9990 after multiple calibration tests, the unit will require 
servicing. 

“r^2C” - The r^2 value only provides useful information when a calibration 
is performed on a linear scale. For non-linear scales, the r^2C shows the 
corrected r^2 value and will provide a better measure of the accuracy of the 
calibration. For linear scales, the r^2 and r^2C values will be the same.

“Temperature” - the temperature of the sample

“Shear Rate” - rotational speed (1/s)

“RPM” - rotational speed (RPM)

“Shear Stress Raw” - the actual signal coming from the unit

“Ref Viscosity” - the viscosity of the sample as calculated by the software

“Ref Shear Stress” - the shear stress as calculated by the software
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Calibration
Fluid Manager

Before calibrating the unit, you must input the specifications of the calibration 
fluid that you are using. This will give the software the information it needs to 
perform the calibration accurately.

Click the “Fluid Manager” button on the Calibration screen to add a new 
calibration fluid batch.

1.	 Click “New” to add a new batch. You can also edit an existing batch by 
selecting it in the “Batch Selector” list.

2.	 In the “Batch” field, type a name for the batch. OFITE recommends using 
the lot number and viscosity from the Certification Chart that was provided 
with the fluid.

3.	 In the “Calibration Fluid Table”, enter at least two Temperature/Viscosity 
pairs from the Certification Chart. Only two pairs are required.

The “Table Linearity Error” light will shine red if the values in the 
“Calibration Fluid Table” do not create a straight line. If this occurs, check 
the values and re-enter them.

4.	 Once you have entered all the batches, click “OK” to close the Fluid 
Manager and return to the Calibration screen.
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Operation
Manual Mode

To begin a test in Manual mode:

1.	 Prepare the Viscometer for a test. Refer to page 8 for instructions.

2.	 Choose the shear stress units from the drop-down box next to the “Shear 
Stress” field. Your choices are: Dyne/cm2, lb/100ft2, Pa., Dial Readings, 
and lb/ft2.

3.	 Enter a value in the “Rotation” field and choose a the units (rpm or 1/s).

4.	 Select the “Enable” checkbox next to the “Rotation” field to start the 
motor.

Once the motor is started, the fields on the right-hand side of the screen 
will begin displaying test data.

5.	 Enter a temperature in the “Temp” field and choose Celsius or Fahrenheit.

6.	 Select the “Enable” checkbox next to the “Temp” field to start the heater.

Here, checking the “Enable” and “PreHeat” button allows you to pre-heat 
the bath to the desired temperature without applying any initial heat to the 
sample. When the bath has reached the temperature set point, raise the 
bath to begin heating the sample.

Remember, if your test will exceed 200°F (93°C), apply the 
recommended pressure based on the chart on page 11.

7.	 Enter a name in the “Experiment Name” field and click the “Start Logging” 
button.

This field will be used to identify the experiment later.

8.	 Enter a comment in the resulting dialog box. Comments are optional, but 
can be used later to identify the test results.

9.	 To stop the test, click the “Stop Logging” button and uncheck the 
“Enable” checkboxes.

10.	Disassemble and clean the unit (refer to page 31 for instructions).

Allow the sample temperature to drop below 120°F (49°C) before 
reducing the pressure. Make sure the pressure reads 0 before 
removing the Rotor Cup.
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Operation
Auto Mode

To begin a test in Auto mode:

1.	 Prepare the Viscometer for a test. Refer to page 8 for instructions.

2.	 Choose a test from the list in the upper left-hand corner of the Main 
Screen.

If no tests are listed, create a new one in the “Test Builder”. Refer to page 
23 for instructions.

3.	 Enter a name in the “Experiment Name” field.

4.	 Set the shear stress units using the drop-down menu next to the “Shear 
Stress” field.

5.	 Click the “Start Test” button.

6.	 Enter a comment in the resulting dialog box. Comments are optional, but 
can be used later to identify the test results.

7.	 Disassemble and clean the unit (refer to page 31 for instructions).

Allow the sample temperature to drop below 120°F (49°C) before 
reducing the pressure. Make sure the pressure reads 0 before 
removing the Rotor Cup.
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Software
Options

To access the Options screen, choose “Options” from the “Edit” menu.

“Enable Bath Level Control” - If this box is checked, the “Raise 
Bath” button on the “Main Screen” will be visible and active.

“RPM DAQ Settings” - “RPM High”, “RPM Med” and “RPM Low”, “Dead 
Time”, “DAQ Time”. These fields are used to determine the amount of time 
needed for the sample to stabilize at a given rate. The fields are also used 
to determine the amount of time data is averaged before being saved. For 
example, if RPM High is set to 60, Dead Time is set to 15 and DAQ Time is 
set to 20, any rate of 60 RPM or greater during a sweep would stabilize for 15 
seconds then begin averaging data for 20 seconds before saving the data. 

“Reverse Rates Gel UI” - If “Hysteresis” is selected on the “Test 
Builder” screen (see page 23), this option will perform a gel test after the 
forward portion of the sweep and after the backward portion.

“Data Archive Directory” - Specify the directory to store archived data.

“Logo Files” - Specify a logo file (.jpg format) to display on the graph at the 
end of the test.

“Time Format” - Choose a time format for all of the ORCADA® software. 



OFITE, 11302 Steeplecrest Dr., Houston, TX 77065 USA / Tel: 832-320-7300 / Fax: 713-880-9886 / www.ofite.com 22

Software
Save Rate Settings

By default, the ORCADA® Software saves data to file based on a set time 
interval. This time interval can be changed by editing the “Raw File Save 
Period” field on the main screen. However, the “Save Rate Settings” feature 
provides more control over data save points. The software will monitor 
each selected variable and record a data point to the file when that variable 
changes by the amount specified. 

1.	 Select “Save Rate Settings” from the “Edit” menu. 

2.	 Place a check mark next to each variable you wish to monitor.

3.	 In the field after the variable name, enter the variance required to initiate 
a save point.

For example, if you want the software to record a data point when the 
temperature increases or decreases more than 5°, place a check next to 
“Temperature” and enter 5 in the field next to it.

4.	 Click “OK” to save the settings and return to the main screen.

“Elapsed Time” - seconds since the start of the test

“RPM” - rotational speed (RPM)

“Shear Rate” - rotational speed (1/s)

“RPM SP” - rotational speed setpoint

“Temperature” - measured sample temperature

“Temperature Bath” - measured temperature of the Heat Bath

“Temperature pH” - Not available on the Model 3025.

“Temp SP” - temperature setpoint

“Temp Duty Cycle” - the frequency (in seconds) the heaters 
engage to increase the temperature

“Viscosity” - measured viscosity (cP)

“Shear Stress” - measured shear stress

“Shear Stress Tare” - change in measured shear stress

“Pressure” - measured pressure

“Pressure SP” - pressure setpoint

“pH” - Not available on the Model 3025.
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Software
Test Builder

The Test Builder is designed to help you build custom tests for use in Auto 
mode. To access the test builder, go to the Main Screen and choose “Test 
Builder” from the “Edit” menu. 

1.	 To create a new test, click the “New Test” button. To create a new test 
based on one of the “RP 10B”, “RP 13D”, or “RP 39” analysis models, 
click the appropriate button at the top of the screen to open a template. 
To edit an existing test, select the test from the list in the upper left-hand 
corner of the screen. 

2.	 Enter a name in the “Test Name” field.

3.	 Choose an Analysis Model.

a.	 “RP 39” - Power Law Model - records the Power Law calculations (n 
and k)

b.	 “RP 13D” - Bingham Plastic Analysis Models - records plastic 
viscosity (PV) and yield point (YP)

c.	 “RP 10B” - Power Law and Bingham Plastic Models combined

4.	 Input the values for your test into the fields in Record 1.

a.	 “Heat Time” - the time it will take the unit to heat the sample to the 
temperature setpoint. If this field is left blank, the unit will heat the 
sample as fast as possible.

b.	 “Heat RPM” - the rotational speed during the heating period

c.	 “Temp” - the temperature setpoint. Enter any letter in this field to 
indicate “Ambient”.

Available Tests Records

Test Detail
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d.	 “Cond. Time” - the time period to condition the sample

e.	 “Cond. RPM” - the rotational speed during conditioning

f.	 “#/Swps” - the number of sweeps to perform after conditioning. 
A sweep is a set of rotational speeds separated by time interval. 
Between sweeps, the Rotor returns to the Cond. RPM. At the end of 
each sweep, the unit calculates the Analysis Model values.

g.	 “Delta Time” - the time interval between sweeps

h.	 “Gel Time 1” - During a gel time interval, the Rotor comes to a 
complete stop and waits. At the end of the interval, the rotational 
speed is increased to 3 RPM until the gel breaks and a gel strength 
value is recorded. Click the “Insert Gel Column” button to add a gel 
time to the record. 

i.	 “RPM 1, 2, 3” - The RPM fields set the speed of each step of the 
sweep.

5.	 Click the “OK” button to save the test and return to the main screen.

“Hold for Temp” - Click this checkbox to tell the unit to wait until the sample 
has reached the temperature setpoint before proceeding to the next step. If 
this box is unchecked, the test will proceed while the sample is heating.

“Temp Threshold” - This field specifies an acceptable variance on the 
temperature. For example, if the temperature setpoint is 150° and the “Temp 
Threshold” is set to 5°, the unit will consider the setpoint reached when the 
temperature is between 145° and 155°. 

“Temp Unit” - set temperature units to either °F or °C

“Rate Unit” - set the rate units to either RPM or 1/s

“Pressure Unit” - set the pressure units to either psi or kPa

“Hysteresis” - If this box is checked, each sweep will be performed forward 
and backwards.

“Stir Parameters” - These parameters only apply if the test includes a gel 
time.

“Stir Prior to Gel” - Check this box to stir the sample before calculating gel 
strength.

“Gel Stir Rate” - This is the rate the sample will be stirred prior to calculating 
gel strength.
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“Gel Stir Time” - This is the time interval the sample will be stirred.

“Plot All Records” - If this box is checked, all records will be plotted on 
the graph. If it is not checked, only the currently highlighted record will be 
plotted.

The graph below the records provides a visual representation of the current 
test. Each line represents one aspect of the test: RPM Setpoint, Temperature 
Setpoint, Pressure Setpoint, and Temperature PV. Refer to the key to the 
right of the graph for details.

The graph features a cursor, a vertical yellow line, that can be used to view 
more detailed information about the different phases of the test. The “Center 
Cursor” button moves the cursor to the center of the graph. Click and drag 
the cursor across the graph to see more detailed information. Refer to the 
“Test Detail” field below the graph for more information. 
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Software
Select Analysis Outputs

After building a test in the Test Builder, the chart at the bottom of the main 
screen will show the various data points being calculated by the Viscometer 
based on the chosen analysis model. This chart, however, is customizable. 
You can choose which data points are displayed on the chart and which are 
not.

From the “Edit” menu, choose “Select Analysis Outputs”. By default, all data 
points are selected and will appear on the chart. To remove a data point from 
the chart, simply uncheck the box next to it.
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Software
Saved Test Data

To review test data from past tests:

1.	 Select “Saved Test Data” from the “File” menu.

2.	 The saved test data is grouped by month. Select the folder for the year 
and month of the data you are looking for and click the small + sign next 
to it. This will show you all of the data for tests run that month, including 
any comments you added.

3.	 Select the test you are looking for and click the “OK” button. Multiple tests 
can be selected by holding down the CTRL key and selecting each test.

Saved Experiment Explorer

4.	 On the “Raw Data” tab you will see the graph of the test results. The 
“Analyzed Data” tab shows the results of the calculations based on the 
Analysis Model. The “Test Setup” tab shows the parameters of the test.

Raw Data
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“Export” - Click this button if you wish to export the test data to a file. You 
will be asked to select a filename and destination and then click “OK”. The 
resulting file can then be opened in Microsoft® Excel for further analysis.

“Print” - Click this button to print the results to the default printer.

“Experiment Explorer” - Click this button to choose another set of test data 
to review.

“OK” - Click this button to return to the main screen.

Analysed Data

Test Setup
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Software
Calibration History

On the Calibration History Screen, you can retrieve the data from all past 
calibration tests.

1.	 Begin on the Main Screen. Select “Calibration History” from the “Utilities” 
menu.

2.	 The calibration tests are grouped by month. Select the folder for the year 
and month of the calibration test you are looking for and click the small 
+ sign next to it. This will show you all of the calibration tests run that 
month, including the fluid batch and any comments you added after the 
test.

3.	 Select the test you wish to view and click the “OK” button.

4.	 You can now see the graph, chart, and fluid batch details.

5.	 Click the “Export” button if you wish to export the calibration results to a 
file. You will be asked to select a filename and destination and then click 
“OK”.

6.	 When you are finished reviewing the calibration history, click the “OK” 
button to return to the main screen.

Calibration History

Calibration History Explorer
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Software
Import/Export

The Import/Export feature of the ORCADA® Software makes it possible to 
transfer a test from one PC to another.

1.	 Begin on the Main Screen. Choose “Export” from the “File” menu.

2.	 Select the tests you wish to export. Hold down the CTRL key to select 
multiple tests.

3.	 Click the “Export” button. You will be asked to choose a destination and 
filename and then click “OK”.

4.	 Copy this file to the destination PC.

	 The file must be placed in the correct folder for it to be available for 
import. To find this folder, first navigate to the folder specified in the “Data 
Archive Directory” field in the Options screen (see page 21 for details). 
From there go to the “ORCADA®” folder and then the “Tests Import 
Export” folder.

5.	 On the destination PC, choose “Import” from the “File” menu.

6.	 Choose the tests you wish to import. Hold down the CTRL key to select 
multiple tests.

	 The “Export” field lists all of the files that are available for import. Once 
you have selected one, the “Tests” field shows which individual tests can 
be imported from that file.

	 Below the “Export” and “Tests” fields is a display-only field that shows the 
folder being scanned for exported tests. Make sure the tests you want to 
import have been placed in that folder.

7.	 Click the “Import” button. The new tests will appear in the list in the upper 
left-hand corner of the Main Screen.

Export Import
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Disassembly This procedure should be performed immediately after every test.

1.	 Lower the Heat Bath.

2.	 Allow sample to cool to below 120°F (48.9°C).

3.	 Gradually decrease the pressure at a rate of 30 - 60 psi (200 - 400 kPa) 
per minute.

4.	 Slowly open the Valve Stem at the bottom of the Rotor Cup (see photo on 
page 9). This will relieve any remaining pressure from the Rotor Cup. 
Keep a container underneath the Valve Stem to collect the sample fluid.

5.	 Unscrew the Rotor Nut and pull the Rotor Cup straight down. Hold it 
directly under the Bob to catch any residual fluid that may be dripping.

6.	 Gently turn the Bob counterclockwise to remove it from the Bob Shaft.

7.	 Clean the Bob and Bob Shaft.

8.	 Remove the Bearing Insert as described on page 34.

9.	 Clean the Bearing and the Bearing Insert.

10.	Wipe out the inside of the Expansion Joint with a rag or paper towel.

11.	It may be necessary to remove the Expansion Joint to clean out any 
remaining fluid.

a.	 Open the front cover.

b.	 Insert a wrench, screwdriver, or other long item into the hole in the 
Rotor Tube to hold it in place.

Rotor Tube

Expansion Joint
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c.	 While holding the Rotor Tube in place, unscrew the Expansion Joint 
and pull it straight down to remove it.

12.	Clean the Expansion Joint.

13.	Clean the Rotor Cup.

14.	Reinstall each of the removed parts.
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Maintenance Before performing any type of maintenance, unplug the power supply 
and bleed off all Nitrogen. Also, be careful not to bend the Bob Shaft and 
Thermocouple.

When working with bearings, be careful not to handle them with your bare 
hands. The oil from your skin can contaminate the bearing.

A good indicator that maintenance is required is if the r^2C value is less 
than .9990 (refer to page 17 for more information). If a calibration check 
using certified calibration fluid shows viscosity readings that are not linear 
at multiple shear rates, this can also indicate a problem that requires 
maintenance.
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The Lower Bob Shaft Bearing (#130-78-17) is close to the test fluid and will 
need to be replaced periodically.

1.	 Lower the Heat Bath.

2.	 Remove the Rotor Cup.

3.	 Unscrew and remove the Bob.

4.	 With a 9/16" socket, unscrew and remove the Bearing Insert.

5.	 Remove the Retaining Ring with Retaining Ring Pliers.

6.	 Remove the Bearing and install a new one.

7.	 Secure the Bearing in place with the Retaining Ring.

8.	 Screw the Bearing Insert back in place. Tighten it hand tight.

9.	 Calibrate the Viscometer.

Maintenance
Lower Bob Shaft 

Bearing

Bearing Insert

Bearing

Retaining Ring

Bearing Insert
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The Upper Bob Shaft Bearing (#130-83-510) is not exposed to test fluid as 
much as the Lower Bob Shaft Bearing, so it will not need to be replaced as 
frequently. However, if readings become unstable or the r^2 value during cali-
bration is less than 0.99, both Bob Shaft Bearings should be replaced.

1.	 Turn the power to the Viscometer off.

2.	 Lower the Heat Bath.

3.	 Remove the Rotor Cup.

4.	 Unscrew and remove the Bob.

5.	 Undo the latches on the side the Viscometer and lift open the top front 
panel.

6.	 Unscrew the Thermocouple Nut on the top of the Cell.

7.	 Unplug the Thermocouple.

8.	 Carefully pull the Thermocouple straight up and out of the Cell.

Do not bend the Thermocouple.

9.	 Unscrew the Cell Cap.

Maintenance
Upper Bob Shaft 

Bearing

Cell Cap

Cell

Thermocouple Nut
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10.	Loosen the two set screws on the back of the Spring Holder.

11.	Push the Bob Shaft up from the bottom.

12.	Remove the Bob Shaft Assembly from the Cell.

13.	Loosen the set screws on the Spring Holder, Spring, and Magnetic Ring.

14.	Remove the Spring Holder, Spring, and Magnetic Ring from the Bob 
Shaft.

15.	Remove the Upper Bob Shaft Bearing.

16.	Place a new Bearing onto the Bob Shaft.

17.	Place the Magnetic Ring, Spring, and Spring Holder back onto the Bob 
Shaft. 

18.	Tighten all three set screws.

19.	Carefully place the Bob Shaft back into the Cell.

20.	Tighten the two set screws on the back of the Spring Holder.

Set ScrewSet Screw

Magnetic RingSpring Holder
Spring
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21.	Screw the Cell Cap back onto the Cell.

22.	Carefully place the Thermocouple back into the Cell and tighten the Ther-
mocouple Nut.

23.	Plug the Thermocouple back into the Control Board.

24.	Close the top front panel and secure it with the latches.

25.	Screw the Bob back onto the Bob Shaft.

26.	Calibrate the Viscometer.
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Maintenance
Rotor Nut

If the Rotor Nut or Expansion Joint are loose, they make shake during 
operation and could damage other components. Both components should be 
firmly attached to the Viscometer. If you detect any back-and-forth movement, 
it will be necessary to tighten them.

1.	 Unscrew the Rotor Nut and pull the Rotor Cup straight down.

2.	 Open the front cover.

3.	 Insert a wrench, screwdriver, or other long item into the hole in the Rotor 
Tube to hold it in place.

4.	 While holding the Rotor Tube in place, tighten the Expansion Joint hand 
tight.

5.	 Place the Rotor Cup back onto the Viscometer and tighten the Rotor Nut 
hand tight.
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Maintenance
Fuse Replacement

There are two fuses that control the power supply. They are located in a small 
compartment by the power switch. Simply use a small screwdriver to pry 
open the compartment and replace as needed.

Additional fuses are located inside the cabinet. To replace these fuses:

1.	 Open the back cabinet by loosening the three quarter-turn screws.

2.	 You will see 4 fuses on the inside. 

The power supply may hold an electrical charge. Be very careful not to 
touch it while changes the fuses.

Label	 Component	 Fuse (115V)	 Fuse (230V)
F1	 Heater	 10 amp	 6 amp
F2	 Motor	 5 amp	 3 amp
F3	 Main	 5 amp	 3 amp
F4	 Heat	 3 amp	 2 amp

Power Supply

Fuses

Fuses
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Appendix
Diagram

Refer to the next page for a list of parts that correspond to the labels on this 
diagram.
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The parts listed below correspond to the labels on the diagram on the previ-
ous page.
#	 Part #	 Description
1	 130-81-550	 Fitting, M Connector, 1/8 Tube OD × 5/16-24 M O-

seal
2	 130-83-015-1	 Cell Cap
3	 130-83-008	 C Clamp for Cell
4	 135-19-1	 Hex Socket Screw, 8-32 × 3/16
5	 130-83-007	 Spring Holder
6		  Screw, Pan Head, 6-32 × 5/8
7		  Washer, Internal Tooth Lock
8	 130-83-003-1A	 Bridge
9	 130-83-501	 Transducer Magnet
10	 120-616	 Set Screw
11	 130-83-613	 Magnet Holder
12		  Screw, Hex Socket Head
13	 130-83-006-1B	 Bridge Support
14	 130-78-22	 Pin for Slotted Spring
15	 130-83-016T	 Cell Body
16	 130-77-069	 Fitting, Connector, 1/8" MNPT × 1/8 Tubing
17	 130-83-023	 Seal Nut
18	 130-81-145B	 Gear 40 Tooth
19	 130-78-34	 Packing Washer
20	 130-78-36	 O-ring for Rotor Tube
21	 130-83-019-1	 Expansion Joint
22	 130-78-20	 O-ring for Rotor Cup
23	 130-78-17	 Bob Shaft Bearing, Lower
24	 130-78-15C	 Bob Bushing
25	 130-78-13A	 Bob, B1
26	 130-81-003	 O-ring for Valve Stem, Upper
27	 170-17	 O-ring for Valve Stem, Lower
28	 130-81-071	 Rotor, R1
29	 130-81-062	 Rotor Insert
30	 130-81-07	 Valve Stem
31	 130-83-010B	 Pin for Bob Shaft
32	 130-78-15B	 Bob Insert
33	 130-83-611	 Insert, Bob Shaft Bearing
34	 130-83-512	 Retainer Ring, Internal
35	 130-81-040	 Retainer Ring
36	 130-83-022-1	 Rotor Cup Nut
37	 130-83-018A	 Rotor Tube
38	 130-81-506-1	 Retainer Ring, Internal, Single Turn Spiral
39	 130-83-505	 Main Bearing
40	 130-78-05	 Main Seal
41	 130-81-146	 Rotor Tube Nut
42		  Screw, Flat Head, Hex Socket, 8-32 UNC × 0.625
43	 130-83-610	 Bearing Tube
44	 130-83-032	 Transducer Board Mount
45	 512-03-800	 Magnetic Encoder Sensor Board
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#	 Part #	 Description
46	 130-75-18	 Wiring Plug for Transducer Cable
47	 142-54	 O-ring, Upper Bob Shaft
48		  Screw, Hex Socket Button Head
49	 130-83-508	 O-ring for Cell Cap
50	 130-83-028T	 Cap Nut
51	 130-83-522	 Retainer Ring
52	 130-83-511	 Retainer Ring, External, Spiral
53	 130-83-614	 Bob Shaft Clamp
54	 130-83-510	 Bob Shaft Bearing, Upper
55		  Screw, Flat Head, Hex Socket
56	 130-81-086	 Screw, Socket Head, 0-80 × 3/16
57	 130-81-082	 Torsion Spring
58	 130-83-612A	 Bob Shaft Bearing
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Appendix
Transducer 

Linearization

The transducer linearization process is only necessary if the transducer, 
transducer board, or control board have been replaced. This process only 
applies to firmware version 1.43 and later. 

1.	 Make sure the computer is connected to the Model 3025 Viscometer and 
that the ORCADA® software is not open. Lower the heating jacket and 
remove the Rotor Cup so that the Bob is exposed.

2.	 Open the Firmware Downloader software.

3.	 Click “Terminal!” on the top menu.

4.	 In the “Connection” drop-down list, choose the method you used to 
connect the Model 3025 to the computer and click the “Connect” button.

5.	 Find the Model 3025 in the list and click the green “Select Device” button.
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6.	 Type M1 in the “Command” field and click the “Send Command” button.

7.	 Next type C and click the “Send Command” button.

8.	 Slowly turn the Bob until it hits one of the stops. Then slowly turn it in the 
other direction until it hits the other stop. Then let go of the Bob and let it 
return to its resting position.

9.	 Send the N command. The software will show details of the calibration. 
Close the software.

10.	Fill the Rotor Cup with calibration fluid and install it.

For an F1B1 configuration, use 200 cP fluid. For an F2B2 configuration, 
use 1000 cP fluid.
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11.	Open the TransCal software supplied by OFITE.

12.	On the “Manage Devices” screen, right-click the Viscometer in the list and 
select “Default Device”. Then click “Done”.

If the Viscometer does not appear in the list, select the correct COM port 
from the list and click the “Search for Devices” box.

13.	Click the “Start Transducer Calibration” button. The transducer calibration 
will run automatically for about 20 minutes. At the end of the procedure, 
the status screen will disappear. Close the TransCal software and open 
the ORCADA® software.

14.	Calibrate the Viscometer through the ORCADA® software before running 
any other tests.
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When calibrating the Model 3025, the “Shear Stress Raw” value on the cali-
bration screen should be between 950 and 1000. If it is not, the Transducer 
Cap will need to be adjusted.

To adjust the Transducer Cap:

1.	 Bleed off all pressure from the system. 

2.	 Open the top cover.

3.	 Loosen, but do not remove the Thermocouple from the top of the Cell 
Cap. Disconnect the Themocouple plug from the control board.

Be very careful to keep the Thermocouple straight. A bent Thermo-
couple will cause inaccurate readings.

4.	 Remove the Cell Cap.

5.	 Loosen the two set screws on the Bridge. 

6.	 Observe the “Shear Stress Raw” value on the “Calibrate Shear Stress” 
screen.

7.	 Slowly rotate the Spring holder until the “Shear Stress Raw” value is be-
tween 950 and 1000. 

The sensor is very sensitive. Only very slight adjustments are required. 
Allow a few seconds for the signal to stabilize between adjustments.

8.	 Once the signal is within range, tighten the two set screws. 

9.	 Observe the signal value after 15 seconds to make sure it does not drift 
out of range.

10.	Put the Cap Cell back on.

11.	Insert the Thermocouple and tighten the fitting. Plug the Thermocouple 
into the port on the control board.

Appendix
Adjusting the 

Transducer Cap

Set ScrewSet Screw

Spring Holder
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Appendix
Driver Install

If using the included Serial to USB Converter cable (part # 130-79-19) to 
connect to the Model 3025, the PC will require a driver. This driver is included 
on the same CD that contains the ORCADA® software. To install the driver:

1.	 Insert the software/driver CD to the computer and select the file labeled: 
CDM v2 1200 WHQL Certified.exe

2.	 A prompt will open, asking if you want to run this file. Press Enter or click 
“Run”.

3.	 The FTDI CDM Driver will open to allow you to extract the driver and 
launch the installer. Click “Extract”.

4.	 A welcome window will open. Click “Next”.
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5.	 Accept the licence agreement and click “Next”.

6.	 Once the driver installation is complete, Click “Finish”.

7.	 Plug the USB portion of the USB/RS232 cable (#130-79-19) to the 
computer.

The computer will continue installing the software. Wait for it to finish 
installing.

8.	 Once the installation is complete, navigate to the Device Manager: 
Click the Start Menu. Open the “Control Panel”. Click the “Hardware 
and Sound” link. Click on the Device Manager link in the “Devices and 
Printers” options.
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9.	 Confirm which communication port (COM Port) the USB Serial Port is 
located in. The window below is indicating that this sample port was 
connected to “COM3” which can be a different COM# depending on the 
computer and the port it was connected to. This is the COM Port that the 
driver has been assigned to.

10.	Open the Options screen in the ORCADA® software. Choose the COM 
port listed in Device Manager.
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When installing ORCADA® on a new computer, it is important to install it in 
the root folder of the C: drive. Do not install it in the “Program Files” or “Pro-
gram Files (x86)” folders.

After installing the software, you will need to tell the computer to run the soft-
ware as an administrator.

1.	 Right-click the ORCADA® icon and select Properties.

2.	 Select the “Compatibility” tab.

3.	 Place a checkmark in the box next to “Run this program as an administra-
tor”.

4.	 Click OK.

Appendix
Installing ORCADA® 
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Warranty and 
Return Policy

Warranty:
OFI Testing Equipment, Inc. (OFITE) warrants that the products shall be free from liens and defects in 
title, and shall conform in all respects to the terms of the sales order and the specifications applicable 
to the products. All products shall be furnished subject to OFITE’s standard manufacturing variations 
and practices. Unless the warranty period is otherwise extended in writing, the following warranty shall 
apply: if, at any time prior to twelve (12) months from the date of invoice, the products, or any part 
thereof, do not conform to these warranties or to the specifications applicable thereto, and OFITE is 
so notified in writing upon discovery, OFITE shall promptly repair or replace the defective products. 
Notwithstanding the foregoing, OFITE’s warranty obligations shall not extend to any use by the buyer 
of the products in conditions more severe than OFITE’s recommendations, nor to any defects which 
were visually observable by the buyer but which are not promptly brought to OFITE’s attention.

In the event that the buyer has purchased installation and commissioning services on 
applicable products, the above warranty shall extend for an additional period of twelve 
(12) months from the date of the original warranty expiration for such products.

In the event that OFITE is requested to provide customized research and development for the buyer, 
OFITE shall use its best efforts but makes no guarantees to the buyer that any products will be provided.

OFITE makes no other warranties or guarantees to the buyer, either express or implied, 
and the warranties provided in this clause shall be exclusive of any other warranties 
including ANY IMPLIED OR STATUTORY WARRANTIES OF FITNESS FOR PURPOSE, 
MERCHANTABILITY, AND OTHER STATUTORY REMEDIES WHICH ARE WAIVED.

This limited warranty does not cover any losses or damages that occur as a result of:

•	 Improper installation or maintenance of the products

•	 Misuse

•	 Neglect

•	 Adjustment by non-authorized sources

•	 Improper environment

•	 Excessive or inadequate heating or air conditioning or electrical 
power failures, surges, or other irregularities

•	 Equipment, products, or material not manufactured by OFITE

•	 Firmware or hardware that have been modified or altered by a third party

•	 Consumable parts (bearings, accessories, etc.)

Returns and Repairs:
Items being returned must be carefully packaged to prevent damage in 
shipment and insured against possible damage or loss. OFITE will not be 
responsible for equipment damaged due to insufficient packaging.

Any non-defective items returned to OFITE within ninety (90) days of invoice are subject to a 
15% restocking fee. Items returned must be received by OFITE in original condition for it to 
be accepted. Reagents and special order items will not be accepted for return or refund.

OFITE employs experienced personnel to service and repair equipment manufactured by us, as 
well as other companies. To help expedite the repair process, please include a repair form with all 
equipment sent to OFITE for repair. Be sure to include your name, company name, phone number, 
e-mail address, detailed description of work to be done, purchase order number, and a shipping address 
for returning the equipment. All repairs performed as “repair as needed” are subject to the ninety (90) 
day limited warranty. All “Certified Repairs” are subject to the twelve (12) month limited warranty.

Returns and potential warranty repairs require a Return Material Authorization (RMA) 
number. An RMA form is available from your sales or service representative.

Please ship all equipment (with the RMA number for returns or warranty repairs) to the following address:

OFI Testing Equipment, Inc.  
Attn: Repair Department  
11302 Steeplecrest Dr.  
Houston, TX 77065 
USA 

OFITE also offers competitive service contracts for repairing and/or maintaining your lab 
equipment, including equipment from other manufacturers. For more information about 
our technical support and repair services, please contact techservice@ofite.com.
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